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ETAS LABCAR-AUTOMATION 4.2

1 Introduction

Introduction

1.1 About This Manual

The aim of this document is to help new users as well as users moving from previous
versions to easily get started with LABCAR-AUTOMATION 4.2. It gives an overview about
new and changed functionalities and summarizes all important information relevant for this
product release. Please read it carefully before you start installing and using LABCAR-

AUTOMATION.

The following typographical conventions are used in this document:

OCI CANTxMessage msg0 =

Choose File > -Open.
Click OK.
Press <ENTER>.

The "Open File" dialog box is
displayed.

Select the file setup.exe
A distribution is always a one-

dimensional table of sample
points.

Code snippets are presented on a gray background and in
the Courier font.

Meaning and usage of each command are explained by
means of comments. The comments are enclosed by the
usual syntax for comments.

Menu commands are shown in boldface.
Buttons are shown in boldface.
Keyboard commands are shown in angled brackets.

Names of program windows, dialog boxes, fields, etc. are
shown in quotation marks.

Text in drop-down lists on the screen, program code, as
well as path- and file names are shown in the Courier font.

General emphasis and new terms are set in italics.

All screenshots in this document relating to previous version of LABCAR-AUTOMATION are

also valid for version 4.2.
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1.2 Product Overview

LABCAR-AUTOMATION is a tool suite for the efficient automation of Hardware-in-the-Loop
(HiL) tests. It provides the following key features:

v Role-based development, management, and execution of automated tests
on Hardware-in-the-Loop systems.

v Open concept for integration of ETAS and 3" party products.

v Powerful .NET®-based test case programming interface supporting various
programming languages.

v Intuitive graphical test case creation.

v Test case parameterization for advanced variant management.

The modular tool suite consisting of several components and add-ons providing features for
certain stages of test automation. More information on specific components and add-ons can
be found in the user guide.

o Runtime core components necessary for the execution of tests.
Components
Automation
Sequence Tool for intuitive graphical test case creation.
Builder
Test Creating, parameterizing and managing of tests as well as creating
Manager test sequences.

Test Handler Execution of test sequences on a specific test bench.

Guided setup of test bench configurations and test projects

Conﬁguratlon (Professional Edition allows configuration for all tool adapters,
Wizard . .
Standard Edition only for installed tool adapter).
Cilitars Several editors allowing to create and edit configuration files.
Package
Project Allows project generation for the Embeddable Package where
Generator Configuration Wizard and Editors are not available.
Report Viewing and analyzing test reports that are generated during test
Viewer execution.
Tool Tool adapters allow the integration of several ETAS and 3" party

Adapters tools in LABCAR-AUTOMATION.

Release Notes 6



ETAS LABCAR-AUTOMATION 4.2 Introduction

1.3 Product Packages

LABCAR-AUTOMATION is available in different product packages, each providing a tailored
package of components and add-ons for a given use case.

LABCAR-AUTOMATION Standard Package

To immerse into the test automation for the first time or to implement test automation
in a rather small or static test bench environment the LABCAR-AUTOMATION Standard
Package is recommended.

LABCAR-AUTOMATION Professional Package

Additional tool connections and features, in-depth managing of configurations and units
under test are the benefits of the effortless extendible LABCAR-AUTOMATION
Professional Package.

LABCAR-AUTOMATION Embeddable Package

Integration of the LABCAR-AUTOMATION into an existing tool chain provides test case
and test project management as well as automated test project creation. They can be
configured and triggered from within customer’s tool chain.

LABCAR-AUTOMATION Easy Offline Package

For graphical or programming-based test case development without the need of online
test execution on the test environment the LABCAR-AUTOMATION Easy Offline Package
is recommended.

The package can be selected by the user during the product installation and requires a
respective license as described in chapter 0.

The table below shows the content of each package. The components and add-ons with a
check mark are part of the respective product package. All others can be ordered and
installed separately to the package.

Release Notes 7
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Core Components
Core Engine
Automotive Test Class v v v v
Library
Manuals and Examples
SuT Mapping File Editor

Report Viewer

Automation 7 7 7 X
Sequence Builder

Confi i Y . ’
O-n IguratIOI‘I (Standard (Prof. (Standard X
Wizard Edition) Edition) Edition)

Test Manager v v X X

Test Handler v 4 X X

Editors Package
Switch Definition File
Editor
Test Bench Configuration v X X X
File Editor
Tool Configuration File
Editor
UuT List Editor

Project Generator X X X

Tool Adapter

Standard
Offline Test Bench v v v v
Connector
ETAS LABCAR-
OPERATOR
ETAS INCA

Tool Adapter

Extened
ETAS INTECRIO
ETAS Real Time Testing 4
ETAS ODX-Link
ETAS Fault Simulation
(ES4440)

Tool Adapter Misc
OCT J1699 X X X X
Microsoft Excel

v’ Part of product package
x Needs to be purchased separately
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1.4

Release Notes

Electronic Licensing

LABCAR-AUTOMATION is protected by electronic licensing. Each component and add-on
requires a respective license. The use of unlicensed ETAS software is prohibited. The
required licenses are not included with the delivery of the product. For more information
about license purchasing contact ETAS.

After purchasing LABCAR- AUTOMATION licenses, you receive a separate entitlement letter
with instructions, how to activate your licenses using a self-service portal on the ETAS
website (http://www.etas.com/support/licensing). During these steps you receive the
necessary license files.

Depending on the license type you need to provide your user name or a MAC address. To
retrieve both, please execute “License Info” included on the LABCAR-AUTOMATION
installation medium (Data\Licensing) or from the "ETAS/License Management/ETAS License
Manager” entry in the Windows start menu via Tools->Obtain License Info->Get License
Info. The information can be saved as file and sent to ETAS.

If you have a valid service contract for LABCAR-AUTOMATION, your license files from
previous versions can be further used with this version.

The use of unlicensed ETAS software is prohibited also in case of service pack installations.
If you have a valid license for the base release, these are valid for the Service Pack as well.
There is no need to require a new or separated license for a service pack. The required
license for the base release is not included in this delivery.
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2

2.1

2.2

2.3

Product Compatibility

System Requirements

The installation and operation of LABCAR-AUTOMATION 4.2 has the following system
requirements:

Pentium PC 1.5 GHz or compatible
(2 GHz Pentium Dual Core PC recommended)

1 GB RAM
Hardware: (4 GB RAM recommended)
(Minimum) 1 GB free hard disk space’
DVD-ROM

Ethernet Adapter 10/100BaseT
(2 x Ethernet Adapter 10/100BaseT recommended)

Operating Microsoft Windows 7

System: Microsoft Windows 8

All software documentation is available in the Portable Document Format (PDF), which
requires Adobe Reader. You can download the latest version from the Adobe website
(http://get.adobe.com/de/reader).

Version Compatibility

The interoperability of the components and add-ons within a certain version of LABCAR-
AUTOMATION is ensured by a common release test. Other setups, e.g. in combination with
components and add-ons from previous versions, are not supported.

LABCAR-AUTOMATION 4.2 is compatible with SuT Mapping File Editor version 4.0.3 which is
included in the LABCAR-AUTOMATION installation.

For latest updates and information visit also the ETAS Download Center
(http://www.etas.com).

Product Compatibility

The open and flexible concept of LABCAR-AUTOMATION allows the integration of different
tools. Following an overview about the tools and respective versions that are currently
supported is given.

! Hint: Application data not considered, esp. maximum size of generated test reports depend on free hard disk space

Release Notes 10
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2.3.1 Supported ETAS Products

Product Compatibility

LABCAR-AUTOMATION 4.2 is compatible to the following ETAS products:

“ Supported Product Compatible Version

Model Access

ECU Access

Sync DL

Diagnostic Access

11699

Fault Simulation

Release Notes

LABCAR-OPERATOR

INTECRIO
(via Common Experiment
Environment 3.2 or higher)

INCA
(via LABCAR-OPERATOR)

INCA

LABCAR-OPERATOR

INCA
(via LABCAR-OPERATOR)

ODX Link
(via INCA 6.2.1/7.0)

ODX Link
(via INCA 7.1)

OBD/EOBD
Conformance Test
System (“OCT”)

LABCAR-PINCONTROL

LABCAR-OPERATOR

(via C interface module)

5.0
5.1
5.2
5.3

3.1.1
3.2
4.Xx

6.2.1
7.0
7.1

7.0
7.1

5.0
5.1
5.2
5.3

6.2.1
7.0
7.1

1.4.2

1.5

4.2.2

2.1.2

5.0
5.1
5.2
5.3

11
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2.3.2

2.3.3

Supported 3™ Party Products

LABCAR-AUTOMATION 4.2 is compatible to the following 3™ party tools:

Supported Compatible Related
Product Version Product Component
Microsoft
Visual Studio 2012 )
Test Design Connector
Editions)
Microsoft
. 2010 Test Bench Connector Excel
Office Excel (TBCEX)

In addition LABCAR-AUTOMATION 4.2 also provides tool adapters for different 3™ party tools
(e.g. dSPACE ControlDesk, Vector CANape and others). However, these tool adapters
typically require customer specific integration and test efforts to ensure full compatibility.
Therefore tool adapters are provided by ETAS Engineering Services on customer request.

For detailed information about available tool adapters or development of specific tool
adapters, please contact ETAS.

Support of ASAM XIL

ASAM XIL is a standard defined by ASAM with the aim to enable reuse of test cases and to
decouple test automation software from test hardware. Please refer to the ASAM website for
detailed information (http://www.asam.net).

The standard contains two parts:

ASAM XIL Framework: Defines interfaces to describe a test case, similar to the LABCAR-
AUTOMATION Automotive Test Class Library (ATCL) concept.

ASAM XIL Test Bench: Defines interfaces to connect test automation software and test
hardware, similar to the LABCAR-AUTOMATION port and tool adapter concept.

The ASAM XIL Add-On provided with LABCAR-AUTOMATION 4.2 provides additional
interfaces of the ASAM XIL standard within LABCAR-AUTOMATION.

This Add-On is not exhaustive and has not yet participated in an official ASAM XIL cross test
to ensure compatibility with other tool vendors. Therefore, it is provided for customer
evaluation purposes only.

Any customer feedback helps to improve the Add-On and can be submitted to the ETAS
Hotline (http://www.etas.com/en/hotlines.php).

The Add-On is based on version 2.0.1 of the ASAM XIL standard. For details about the
available interfaces and detailed description refer to the documentation which is part of the
Add-On installation.

Release Notes 12
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3 Product Installation

To install LABCAR-AUTOMATION please follow the guidelines described in chapter 2
“Installation” of the user’s manual provided in the “Data/Documentation” directory of the
installation CD.

In general the following issues should be considered for installation.

=

444

Do not mix products and/or add-ons of different versions of LABCAR-AUTOMATION V2
or V3 software. (LABCAR-AUTOMATION V1 can be operated in parallel to LABCAR-
AUTOMATION V3)

Shutdown all running applications (especially all ETAS applications have to be closed).
Uninstall previous versions of LABCAR-AUTOMATION

Please follow Chapter 3.1 of this document if you like to take over your Test Handler
options (new feature since LABCAR-AUTOMATION 3.4).

For a convenient LABCAR-AUTOMATION installation please use the guiding htm/
pages, opened when inserting the CD into the PC drive. If the Auto Play option of
your disk drive is switched off, please start the autostart.exe from the root of the CD
directly.

Before installation of LABCAR-AUTOMATION the installation of Microsoft .NET
Framework V4.0 is required. One may find the installation of Microsoft .NET
Framework V4.0 Redistributable at the Installation CD.

For Korean installation only: After installation of Microsoft .NET Framework a reboot of
the PC is required.

The Report Viewer internally uses the Internet Explorer installed at your system to
visualize the reports. To visualize plots present as SVG files an appropriate SVG viewer
/s necessary. At Windows 7 systems assure that Internet Explorer 9 is installed (it
includes a SVG viewer by default).

Special installation guidelines regarding other ETAS products and 3rd party products can be
found in the chapter “Hints” at the end of this document (Chapter 5)

3.1 Test Handler Options

The options of the Test Handler are managed in a configuration file. During installation these
options are preset as follows:

Release Notes

In case of a fresh installation these options are set to default values.

If it is intended to use the Test Handler options from a former version (different
installation folder) you can export it with the old version before uninstall the old
version and then import the options into the new version after the installation.

If you use the import function the Test Handler has to be restarted to reflect the
changes resulting by the imported options file.

Starting with LABCAR-AUTOMATION 4.2: If you had formerly installed the same

version (same installation folder by default), or another version in the same target
folder, the Test Handler options were not deleted during uninstall or during repair
installation. The saved options are taken over for the new or repaired installation.

If you like to force an initial set of Test Handler options, please delete the
corresponding ToolOptions.conf file (e.g. for Windows 7 file

"%ProgramData % |ETAS|LABCAR-AUTOMATION 4. 1.0|conf|ToolOptions.conf”)
manually.

13
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3.2 SuT Mapping File Editor (SMFE)

The SuT Mapping File Editor (SMFE) comes together with LABCAR-AUTOMATION 4.2. It will
be automatically installed when one of the LABCAR-AUTOMATION packages will be installed
on your computer.

= During uninstallation of LABCAR-AUTOMATION the LABCAR-SMFEditor 4.0 is not
uninstalled.

= It has to be manually uninstalled in the Windows control panel via Settings — ->
Control Panel -> Add or remove programs.

LABCAR-OPERATOR (LCO) brings the same version with its installation. If installed with
LABCAR-AUTOMATION (LCA) as well as LABCAR-OPERATOR the SMFE will not be uninstalled
before both (LCA and LCO) are uninstalled.

3.3 Installation of Further Components

In case you extend your system with further components there are two ways depending on
the component you like to install.

jE! LABCAR-AUTOMATION 4.1.0 Setup

Change, repair, or remove installation

All components and Tool Adaptors which are
part of one of the LABCAR-AUTOMATION
packages (ref. to chapter 0) are available via
the setup. You just have to insert the LABCAR-
AUTOMATION product CD and start installation

Select the operation you wish to perform,

¥ o)
1)

.l ; # Lets you change the way features are installed.

again. A [ e
Lij. Repairs errors in the most recent installation by fixing missing and corrupt
files, shortcuts, and registry entries.
= If the installation does not start after =

@j Removes LABCAR-ALTOMATION 4. 1.0 from your computer.

insertion of the CD, the option to
autostart’ the media is disabled in your

explorer. In this case double click the Py ot
autostart.exe file at the root directory of
your CD.

As soon as the LABCAR-AUTOMATION setup was started successfully you have the choice to
change, repair or remove the package. Please select Change.

The next window provides you the possibility to select the components to install additionally.
All former installed }i_rtis are already selected. If it's already installed it is marked as @,
otherwise a cross X _~lis shown. To select a component click on this icon. In the picture
below for example the FS port Tool Adaptor will be newly installed:

= =] LABCAR Automation
S — | '| Core Components
- | Manuals
= | Basic components
~ | 5uT Mapping component
hell Components
~ | Test Creation
~ | TestManaging
= | TestHandling
~ | Editors
Misc
Q-l Configuration Wizard
== | Tool Adapters
RealTime Scripting ToolAdapter
dSpace ToolAdapter
Diagnose ODX Link ToolAdapter
Fault Simulation ToolAdapter (ES54440)

=) Wil be installed on local hard drive
=38 Entire feature wil % installed on local hard drive

U

E|®

== |

e

[opefole

B

PP

X Entire feature wil be unavailable
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= The component Configuration wizard contains both, the standard and the
professional version. If you have already installed the LABCAR-AUTOMATION
Standard package and like to upgrade the Configuration Wizard to the
professional level you do not need to install or re-install the component. The
control about the level is realized completely by the license you've got. It is also
not necessary to remove the Configuration Wizard Standard License
(LCS_LCA CWS) from your computer, your initial license file or at the license
manager. The component recognizes automatically the higher level.

Click Next and confirm the change at the next page. The completion will be reported in the
final window.

3.3.1 Registry Changes

The root path in the registry for the LCA has changed and now does not contain any more
the version: "HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\LABCAR-AUTOMATION". Below that
path there is a registry folder with the current version.

Since the product version was changed so that it only has two digits the registry key look
like the following: "HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\LABCAR-AUTOMATION\4.2"

3.3.2 Additional Components

There are some additional components available which are not installed with one of the
predefined packages:

e Tool Adapter for Microsoft Office Excel Tables
e Tool Adapter for Onboard control tester / 11699 Standard

All of these components you can install via the separate tools and utilities entry in the
Installation CD Menu.

Select at the next window the ETAS Add-Ons at the right menu pane or select the first link
,Get a list of the related LCA utilities and our Tool adaptors here.’

Select the Add on you like to install by clicking the appropriate link.

Depending on your security level you might get one or two security information if you allow
the download of the file (from your installation CD). Please confirm this dialogue with ,Run’
and the installation will starts.

Release Notes 15
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3.4 Service Pack Installation

To install LABCAR-AUTOMATION please follow the guidelines described in chapter 2
“Installation” of the user’s manual provided in the “Data/Documentation” directory of the
installation CD.

= Please follow chapter 3 Product Installation to see all relevant
information of the installation

A LABCAR-AUTOMATION Service Pack comes as a complete delivery of the
LABCAR-AUTOMATION software package.

= It is required therefore to uninstall the previous used version, if you have
Installed
a former build or
a former service pack.

For the installation of the Service Pack please do the following:

Install the LCA package from this CD as usually and select the package which is the
valid one for you. (Standard, Professional, ...). Follow the instructions for a normal
installation. Important hints you find as well at chapter 5 Important Notes.

In the case you had installed up to now additional tool adaptors, these have to be
installed as well newly, to provide them for the execution chain. Access the installation
again and select through the bullet 'Custom’ the appropriate adapter and start the
installation. See chapter 3.3 Installation of Further Components for detailed
information.

= Licenses are not to be changed for a service pack.

Release Notes 16
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4.1

Changes in LABCAR-AUTOMATION 4.2

This chapter describes major changes of LABCAR-AUTOMATION 4.2 with respect to the
previous version.

New Functionality in LABCAR-AUTOMATION 4.2

4 LABCAR-AUTOMATION 4.2 main features at a glance:

v~ Support of Microsoft Windows 8 and Microsoft .NET 4.5

v~ ASQ Batch Generator for Automation Sequence Builder

v~ Tool Adapter for ETAS INCA 7 and ETAS LABCAR-OPERATOR 5.3

v~ Report Viewer standalone installation

v~ ASAM XIL Evaluation AddOn for LABCAR-AUTOMATION

Support of Microsoft Windows 8

LABCAR-AUTOMATION now officially supports Windows 8. Other versions, e.g. Windows 8.1,
are not fully covered by release tests and might be used without warranty for compatibility.

Support of Microsoft .NET 4.5

LABCAR-AUTOMATION is now based on Microsoft .NET framework 4.5 (compared to
Microsoft .NET 4.0 in LABCAR-AUTOMATION 4.1).

If test cases are compiled with LABCAR-AUTOMATION 4.2, .NET framework 4.5 needs is
required. However, test cases already compiled with previous versions can still be executed
with LABCAR-AUTOMATION 4.2.

ASQ Batch Generator for Automation Sequence Builder

Automation Sequence Builder now provides the ASQ Batch Generator to automatically
generate all .asq files within a selected folder. The feature can be found in Automation
Sequence Builder under Tools -> Plugins -> ASQ Batch Generator.

Release Notes 17
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[ ASQ Batch Generator = | | _
Source Folder  CA\Users\Public\Decuments\ETAS\LABCAR-AUTOMATION 4.2 -] @ Subdirectory
Generatar ATC TesiCasehSBGenerator T .|
Cutput Folder  C\Usersileh2abt\Desktop |

~ | Details

Status  Sequence Name Description

40 %0 @0 Ready

The dialog allows to select an input folder (where your .asq files to be generated are
located). With the checkbox behind that selection you can decide if also the child directories
shall be recursively scanned for ASQs to be generated. The results of the generation will be
stored in the selected output folder (existing files will be overwritten). The generation will
use the selected generator (e.g. to decide between generation of test case executables or
libraries). Information about successful or unsuccessful generation for each .asq file will be
shown in the lower part of the dialog.

Tool Adapter for ETAS INCA 7.1 and ETAS LABCAR-OPERATOR 5.3

With LABCAR-AUTOMATION 4.2 a new INCA standalone tool adapter is available. This tool
adapter allows to connect LABCAR-AUTOMATION directly with INCA for accessing ECU
calibration, measurement and diagnostic data. A separate LABCAR-OPERATOR license is not
required.

As in previous version, also a tool adapter for accessing INCA via LABCAR-OPERATOR is
provided. This tool adapter allows in comparison to the standalone tool adapter also a
synchronized logging of INCA and LABCAR-OPERATOR data. However, this requires an
additional LABCAR-OPERATOR license.

Both tool adapter support now the latest INCA version 7.0 and 7.1. Equal to previous
versions of LABCAR-AUTOMATION, the Configuration Wizard and the Test Bench
Configuration File Editor allow to select and configure the respective tool adapter.

Tools | Ports

B[] ECUAccessMeasurement » Help
----- CAMNape 8.0

----- [[] INCAS 4 {Standalone)

----- [[] INCAS 2 {Standalone)

----- [[] INCA V7.1 (Standalone)

----- [] INCA V7.1 (Standalone) with OD¥ 1.5
""" [] LABCAR-OPERATORS.0 with INCAS.4
""" [] LABCAR-OPERATORS.0 with INCAG.2
""" [] LABCAR-OPERATORS.0 with INCAG.2
""" [] LABCAR-QOFPERATORS.1 with INCAG.2
""" [] LABCAR-OPERATORS.1 with INCAG.2

m

For the different possibilities to use INCA with LABCAR-AUTOMATION, please see ‘How to..."-
document chapter 2.4.1.
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4.2

Report Viewer Standalone-Installation

The installation of LABCAR-AUTOMATION 4.2 now offers to install only the Report Viewer
without other product components. The Report Viewer can be used without license. This
enables to distribute test reports generated with LABCAR-AUTOMATION within the
organization and conveniently view them, e.g. for review or analysis purposes.

ASAM XIL Evaluation AddOn

The ASAM XIL Evaluation AddOn provides many of the interfaces as specified in the ASAM
XIL standard, e.g. to integrate with 3 party tools. For a more information refer to chapter 0
of this document.

Others

Besides the described key features there are several smaller or hidden improvements of
LABCAR-AUTOMATION. Chapter 4.3 gives an overview of customer issues solved with this
version of LABCAR-AUTOMATION.

Automation Sequence Builder now comes with improved memory consumption and
provides now a better performance and reactiveness than ever before. The Favorite panel in
Automation Sequence Builder now also allows to store so called Value-Stencils (those with
an round icon on their top).

For the property panel of the SuT Mapping File Editor, a check of the property values is
introduced.

Migration From LABCAR-AUTOMATION 3.1 to LABCAR-AUTOMATION 4.2

Data structures from LABCAR-AUTOMATION 3.1 projects must be converted to the current
data structures.

Please be careful that projects that shall be opened with LABCAR-AUTOMATION 3.1 may not
be opened and saved with LABCAR-AUTOMATION 4.2.x.

= After opening a project with LABCAR-AUTOMATION 4.2.x the project cannot
be opened with previous versions (3.1 and earlier)

A detailed description of migration steps and hints regarding the change of version is
available in the document “"LABCAR-AUTOMATION - From 3.1 to 3.2.pdf” which can be
found in the LABCAR-AUTOMATION start menu group and on the installation CD.
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4.3 Solved Customer Issues

The following known issues are solved with LABCAR-AUTOMATION 4.2 (ID and Title
referring to the ETAS Issue Tracking System).

-

Test Manager: Positioning toolbars

373311
413719 Test Handler: Plot Display Settings Plot Height and Width
385397 ASB: New sequence is hidden behind Welcome... tab
407984 ASB: Verify DTC - 'Bus doesn't exist' error with no TLA
437669 ASB: _Calcullat'ion using Units: ERROR: Cannot convert from
no unit to '%
ASB: Stencil Configure Signal Generator must be named
420132 ; ;
like Signal Generator Name
420139 ASB: Help, documentation and example improvements
(Configure SG, Fault Simulation)
410150 ASB: Crashes by opening if Global Switch Definition File

format is incorrect
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4.4

4.4.1

4.4.2

4.4.3

Known Issues

This section describes known problems of the released version 4.2.

Single Element Access for Arrays in Model Access - Datalogger

LABCAR-OPERATOR V3.2.x/4.1 cannot handle single element access of arrays in the
datalogger configuration. The following signature usage does not work:

port.ConfigureDatalogger (AtclTypes.TypeDLConfigureRecord (
log filename,
10.0,

[AtclTypes.TypeSelectSignalRecord (“Engine[index]”, ”"AcquisitionTask”) 1,

Code example for LCO 5.0:

private string LabelCompleteArray = "Internal maDouble";
private string LabelToolLabelIndex = "Internal maDouble Index";
private string DataloggerIndexLabel = "Internal maDouble[1]";
private string AcquisitionTask = "AcquisitionTask";

// Configure the Data Logger
TypeDLConfigureRecord dlConfigure = new TypeDLConfigureRecord (
dataloggerFile,
10.0,
new TypeDLSignal []
{ new TypeDLSignal ( DataloggerIndexLabel ,
Ports.ModelAccess , AcquisitionTask ),
new TypeDLSignal ( LabelToolLabelIndex ,
Ports.ModelAccess , AcquisitionTask )
}
)7

Experiment Environment 3.2.0

In/Out Ports which are not connected to the model by the Experiment Environment (EE) are
not possible to be switched between Modes 'Signal generator' or 'Constant' by LABCAR-
AUTOMATION via EE3.2.0 and the values of these In/Out ports are not accessible.

This issue has to be solved by the Experiment Environment. The solution is solved with
EE3.3

Measurement of INCA Indexed Values

Starting from INCA 6.2.1 HF17 for indexed values in INCA a new feature is available. It can
be decided by the customer, where the index will be oriented in the naming:

Option Index Alignment = ‘Left’: aaaal[l] .bbbb.cccc.dddd
Option Index Alignment = ‘Right’: aaaa.bbbb.cccc.dddd[1]

The default selection with this feature is ,Left’, while the orientation in the past was ,Right’,
therefore LABCAR-AUTOMATION translates all indexed values like ,right-oriented’.
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4.4.4

4.4.5

4.4.6

4.4.7

To ensure correct operation with the
datalogging of indexed values it is
necessary to set the user option in
INCA correctly.

Select from Menu Bar -> Options ->
User options and activate the tab
,Experiment’. Look at this tab for the
entry ,Index Alignment’ and set it to
,Right'.

This option setting is only necessary
once after the installation of the INCA
Hotfix.

Changes in LABCAR-AUTOMATION 4.2

p
User options - User: «

> S

HexFiles |

Data exchange ] ASAM-2MC Editor ] General ] Autostart

%2 ODX | Limited EMURAM | Calibration Session Log | Path

l

Autecommit Import / Expert ]
l

l

MName Alignment

:IndexAIianment |

View of search dialog

Automatic start of data
visualization

Display variables of all
subfunctions

4 m

Database Experiment & Hardware
Option Value
IMeasure <-General, Measure window, Osc
Calibration «<-General, Calibration, Table edi

Adjust font in the variable views |Left
if the view size is changed

The index (e.q. for array-sub-element names) will be added te  »
the right hierarchy location in the format
aaaa.bbbb.cccc.dddd _[1]

Left

|Left

By Structure
No

Yes

b

OK Cancel Default

No Calibration of TAB_VERB Array Parameters Possible

It is not possible to set array parameters defined in INCA (.a2l) as TAB_VERB. However

reads are possible.

Maximal Path Length and Special Characters

Windows restricts paths to a maximal length of 248 characters. This should be kept in mind
when setting up LCA projects. E.g. when creating project structures with the Configuration
Wizard or the Automation Sequence Builder the root directory should not be placed too deep
downwards the directory tree. The resulting path lengths result from that root directory as
well as the length of the project/test name given.

Further the usage of special characters should be prevented. Means no special characters
should be used within path (directory and file names) used with LCA.

Maximal Nesting Depth in Automation Sequence Builder (ASB)

Due to a restriction of WPF (the .NET base technology that is used a base of ASB) there is a
restriction in the maximal nesting depth of stencils in ASB. With the currently used
framework version (.NET 4) this threshold is at 35 stencils nested into each other.

Changed Behavior of Copy & Paste of Hierarchies in SuTMapping Editor

With the introduction of the new SuT Mapping Editor 4.x when copying hierarchies the
related test label are no more copied. This was done as hierarchies are purely seen as
structural elements. It was not seen as sensible to duplicate all related lables.
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4.4.8

4.4.9

4.4.10

4.4.11

4.4.12

4.4.13

4.4.14

ASB Stencil Fault Simulation

In case of selection of multiple errors in the ASB stencil Fault Simulation only the LoadFlag
of the last error entry is been used. That means in case the load flag is set for the last error
in the multiple error set, all errors of the multiple error set are connected with load.

TTCN3 no More Supported

With LABCAR-AUTOMATION 4.x the usage of TTCN3 to implement test cases is no more
supported. It is neither possible to build new TTCN3 based tests nor to use those ones that
were built and used with older versions of LABCAR-AUTOMATION.

Debug Break in Test Handler

With LABCAR-AUTOMATION 4 the behavior of DebuggerBreak functionality available in the
Test handler application has changed (available at the 7est Case Executor page of the
options dialog Tools > Options...).

When having the DebuggerBreak flag set to True, at the beginning of each test execution
the “VS Just-In-Time Debugger” window appears that allows you to select a Visual Studio
instance to be used for debugging. If aborting this dialog (by pressing the Ao button) the
test execution will abort at all. Means the resp. test will no more be executed, but the next
test case of the sequence will be started.

PDF Report Sink

With LABCAR-AUTOMATION 4 a new Report Sink is available. When using this report sink
the memory consumption of the LABCAR-AUTOMATION Core is higher than before and
sufficient memory needs to be ensured, esp. for endurance tests.

Support of ODX 1.5 With INCA 7.1

The support of ODX 1.5 with INCA 7.1 was added to the LABCAR-AUTOMATION. The
configuration can be done either over the TCF Editor or the Configuration Wizard.

It is not possible to directly reuse INCA databases with ODX 1.4, since the configuration of
ODX in INCA has been changed. There is no possibility to migrate the INCA database to
directly support ODX 1.5. This has to be set up from scratch.

The INCA 7.1 and ODX 1.5 tool configurations have both gotten a new property “Initialize
Hardware” to switch off or on the call of initialize hardware in the configure call of the tool
adapters. For the usage of ODX 1.5 this has to be switched off (set to “false”).

Debugging in the Automation Sequence Builder With Nested Sequences

In case of debugging of nested sequences there are some changes/improvements. When a
nested sequence contains a breakpoint and the debugger stops, the nested sequence now is
opened. Formerly the sequence was not opened but nevertheless the debugger stopped and
the user did not see it.

The debug messages now are no more written to the currently active sequence, but to the
sequence to which they belong. Additionally when a nested sequence is debugged, all
messages written to the debug output from the time beginning when the nested sequence is
started to be debugged, are written to the output of the main and the nested sequence.

Generate or Debug an Unsaved Sequence

It is no more possible, to generate or debug a sequence that never has been saved. The
reason for this behavior is, that it is not obvious to the user, where the generated files are
saved. If a user starts the generation or debugger a save as dialog is shown. After saving
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4.4.15

4.4.16

the generation or debugging is continued. In case of the abortion of the saving, generation
or debugging is cancelled and the following message is written to the message log:
"Sequence has to be saved before test case generation can be started! Generation and
debugging is cancelled."

This behavior applies only if a new sequence was created and was not yet saved. This
means a sequence is not saved if it just contains unsaved changes.

GetLoggedSignals Exception: Channel Times Could not be found in file

With the method “GetLoggedSignals” a file is loaded into the memory. If the file size is large
(app. wth more than 250 MB), this can exceed the available memory and an exception is
thrown. This memory limit is given my Microsoft Windows for 32 Bit applications. As
workaround the selection of a recording task that reduces the number of logged signals or
to use a single signal read methods instead.

Problems with debug execution if sequence contains blank and minus

If a .asq file name for Automation Sequence Builder contains a space follow by a minus (e.g.
“File -.asq") an execution of the sequence in debug mode is not possible. As temporary
workaround, a different file name should be chosen.
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5 Important Notes

This chapter lists information and latest issues which are important to know by the user.

5.1 Installation Hints for LABCAR Test Benches Operating With LABCAR-AUTOMATION

The following information is addressed to users working with different ETAS and non-ETAS
tools on a test bench.

When installing LABCAR-AUTOMATION it is recommended to keep the following
sequence for the ETAS Software products:

INCA

ODX Link
LABCAR-OPERATOR
LABCAR-AUTOMATION

PN

It is recommended to use only one LABCAR-OPERATOR Version on your PC, since
frequently switches between the different versions might cause inconsistent entries in
the Windows registry.

If you like to use different LABCAR-OPERATOR Versions in please read chapter 0

Release Notes 25



ETAS LABCAR-AUTOMATION 4.2 Important Notes

= Known Issues.

LABCAR-OPERATOR V3.x and ODX Link V1.x

ODX Link is recommended to be installed before LABCA-OPERATOR to avoid
version conflicts with internal GUI components (LABCAR-OPERATOR Active
GUIs may freeze in case this sequence is not followed).

Java Virtual Machine

The Java Virtual Machine should be installed before LABCAR-OPERATOR is
installed.

5.2 Issues due to 3" Party Products

While installing LABCAR-AUTOMATION or one of its add-ons: In case you detect an error
like "Error 1335: The cabinet file ... is corrupt and cannot be used" and if you ignore the
error message, it repeats with a different cabinet file name, this is a Microsoft Installer
issue. Please re-install the Microsoft Installer software. You find it at the installation CD
under Tools and Utilities -> 3™ party products.

In case you get an error like: "invalid page fault in module MSVCRT.DLL" or "<any
program> causes an exceptional fault in the module MSVCRT.DLL" or similar, you see
Microsoft error reports, which are caused by several run time libraries like for C, C++
and WCF. As ETAS software bases on Microsoft library functions this might occur as
soon as you've installed e.g. the LABCAR-CCI standalone package. These libraries need
a minimum version number or even the latest updates of the concerned dlis.

To prevent these errors you have to manual copy some Microsoft DLLs into your installation
directory of the LABCAR-CCI standalone component or into the Windows\system32 folder.
You find these libraries at the installation CD under Tools and Utilities -> 3rd party products
at the chapter ‘Runtime Libraries of Microsoft '.

Release Notes 26



ETAS LABCAR-AUTOMATION 4.2 Important Notes

5.3 Additional Tool Adapters

If you perform a

repair installation or
the installation a service pack or
an installation into the same folder like a former installation,

all additional tool adapters (e.g. Excel) have to be re-installed after the LABCAR-
AUTOMATION installation.

Solution Explorer - Solution ‘TdleCtrl ... » 1 X |

Another practicable method is to set inside the %ﬁ’mﬂ — LE?‘%
Visual Studio Project for the reference to the = References =
ATCL the option ‘Specific Version’ to ‘False’. ( e
This enables VS as soon as the project is built %Somn e B) spechcveron
to adapt the ATCL version to the actual one, = vy

ion of an assembly.
registered in the global assembly cache.

5.4 General Hints

Since LABCAR-AUTOMATION V3.2.x a LABCAR-AUTOMATION engine log file will be created
(instead of an SAR log file).

You can find the actual logfile(s) directly via the Test Handler Menu at
Tools -> View SAR Log
Tools -> Add In... -> Test Handler Log
Tools -> Add In... -> LABCAR-AUTOMATION engine Log

Selecting one of + Test Handler ‘
the log files opens | Fie Edt Execution [[ Tools | Felp 1
thg Iatgst file 3 @ e f[ 2aaim TestHandler Log idh fop
which is been l View SAR Log CirlsL LABCAR-AUTOMATION Engine Log 4
filled by the last M Tk ConErTeney Test Case Status | Start
Test Handler run. % Test Bench Overview
()| Opfions...
N S BTSN S

Additionally you can find the files in your folder structure at following location:
C:\Users\Public\Documents\ETAS\LABCAR-AUTOMATION 4.2\logging
Filenames:

easSAR.log

TestHandler.log

LABCAR-AUTOMATION Engine.log

Any file with the extension .log.# (#=1...n) covers the history of the appropriate log file to
avoid too big log files. Typically the actual log file is sufficient for problem analysis.

5.5 Windows 7 Restrictions for Test Case Execution

All test cases which are compiled at a Windows 7 System have to use the compile option
‘Compile for x86'.
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5.6 ATCL Example Testcases

The ATCL Example testcases project contain different tests. There are test bench
configuration files available for this project for different Experiment Environment versions.

The diagnostic test contained in the project has a separate test bench configuration file
(ODXAccess).

For the realtime scripting example there is only an example configuration available to be
used with Experiment Environment in version 3.3.

Additionally there is an example available for the excel tooladapter. This example runs in fail.
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6 Error List

Error List

In this chapter you find information and hints when LABCAR-AUTOMATION throws
exceptions. This list is not exhaustive. It is an assortment of exceptions caused by test cases’
design or test bench configuration issues.

| Exception ] Possiblecauses _____________JRemedy |

AtclConnect
Exception

Atclfactory
Exception

IllegalVerdict
Exception

Parameter
Manager Exception

ToolAdapter
PortStatus
Exception

TypeMissMatch
Exception

Release Notes

Thrown if there was a problem
connecting the test case and the
SARHost (execution host), e.g the
SUT-Mapping file mentioned in the
test bench configuration file is
missing. Check the 'ErrorCode’ for
more information.

Indicates a problem in the
AtclFactory, e.g. the library
Etas.EAS.Atcl.Interfaces in version
1.0.0.2 is referenced, but the Sar-
Host still requires version 1.0.0.1

The IllegalVerdictException indicates
an illegal state transition within the
Verdict class. The state transition of
the Verdict is limited to the verdict
transitions of TTCN-3. Cannot be
provoked from within a test case

This exception is thrown if there was
any error in the IParameterManager,
e.g. when test case tries to load a
parameter that has not been
registered.

Used to indicate an abnormal tool
adaptor status to the ATCL API
user/program. It contains the
TypePortStatusRecord to enable the
user to react on the invalid state of
the tool adaptor. It may occur on
every call to a tool adaptor port. It is
thrown e.g. when a test case tries to
configure a port, that is not in the
state ,ToolConfigured'.

Indicates a problem on the type
conversion inside the TypeSutBase

Read exception message
and log-file and fix the
problem mentioned there,
e.g. give the right SUT-
Mapping file as named in
used the .tbc file or adapt
the .tbc file

An error within the Factory
class cannot easily be
provoked from within a test
case. If ATCL in wrong
version is referenced in test
case compared to version
expected by the factory.
Reference the right ATCL
version in your solution
before re-build.

Trial to set a verdict from
error or failed to pass is
invalid and therefore
ignored (that means no
exception), if done in the
test case.

Only if for some reason (e.g.
manipulated verdict class) a
transition within the verdict
class itself goes wrong, an
exception is thrown.

Register the parameter in
the test case before loading.

Set the tool into the right
state before starting the test
or include a tool
configuration into your test
case. Information can be
found inside ATCL
referential and the
examples, came with the
installation of LABCAR-
AUTOMATION.

This is an internal error and
can therefore not be
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Error List

| Exception ] Possiblecauses ____________JRemedy |

ETAS.LCA.SAR.
Core.Interfaces.Ex
ceptions.
PortMissing
Exception

Release Notes

classes. The conversion problem can
either occur during the
transformation to the SAR internal
types or on the way back from the
SAR internal data type to the
TypeSutBase types.

Arises if you try to create a port
which instance name is not declared
in the test bench configuration file.

provoked from within a test
case. Call LABCAR hotline to
get support on this.

Correct the name inside test
case or add the port into the
test bench configuration file
or correct its name therein.
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7 ETAS Contact Addresses
ETAS HQ
ETAS GmbH
BorsigstraBe 14 Phone:  +49 711 34230
70469 Stuttgart Fax: +49 711 3423 2106
Germany WWW: www.etas.com

ETAS Subsidiaries and Technical Support

For details of your local sales office as well as your local technical support team and product
hotlines, take a look at the ETAS website:

ETAS subsidiaries WWW: www.etas.com/en/contact.php
ETAS technical support WWW:  www.etas.com/en/hotlines.php
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